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Welcome to the Mortgage Master on-line documentation and help file.      Mortgage 
Master is a Windows 3.x application and uses standard Windows techniques.    This 
document covers areas that are specific to Mortgage Master.    If you need information 
about using Windows, please refer to your Microsoft Windows documentation.

Mortgage Master helps you make informed decisions on what probably will be the largest 
investment of your life--your home.    Mortgage Master is the quickest way to calculate all 
aspects of home mortgage loans.    Don't depend on the real estate agent or mortgage 
company to choose the best loan for you.    Remember, they don't really work for you or 
have your best interests in mind!

Procedures

To make best use of Mortgage Master, your first step is to select the File menu, Edit
Mortgage Info command.    Enter the principal, interest rate, term of the loan (in 
years), payment options (how often payments are made), and start date.    Then press
the Payment button to display the normal payment required for the loan.    If you want
to save these loan parameters for future use, select the File menu, Save Default Info 
command.    Each time you start Mortgage Master, these default loan parameters 
are read from the initialization file (MM.INI) if it exists.

Once you've entered the basic mortgage parameters, you can calculate the loan's 
remaining balance (if you've been paying on it for a while) by selecting the Calculate 
menu, Remaining Balance command.    To find the cost of the mortgage over its full 
term, select the Calculate menu, Cost of Loan command.    You can have Mortgage 
Master compute any one of the four parameters of a loan by selecting the Calculate 
menu, Missing Variable command.

Mortgage Master will display or output amortization schedules by selecting the 
Reports menu, Amortization Schedule command.    In addition to viewing them on the 
screen, you can optionally send amortization schedules to a file or printer.    To 
perform "what if" analyses of different mortgages, use the Reports menu, Mortgage 
Comparisons command.

Help

Help for Mortgage Master is accessed two ways:

- Pressing F1 (when no menu is highlighted)

- Using the Help pulldown menu

General help areas are listed in the index.

Notes:    Mortgage Master will calculate any type of loan (not just mortgages) as long as the term of the loan is in
years.    Use it to analyze your car loan, your business loan, or any situation where you are borrowing or lending 
money.    In any case, Mortgage Master can save you money and make you an informed consumer.



Mortgage Master is compatible with Microsoft Windows versions 3.0 and has been tested with the beta 3.1 
version (expected to be released to the public in late '91 or early '92).



Mortgage Master Index
To display a topic, click on the underlined title.
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Mortgage Information Help
In the Mortgage Information dialog box you must enter the various parameters of the loan.

Principal Enter the full amount of the loan principal, up to 9 digits.    Do 
not enter a dollar sign ("$") or commas.    Principals from 
$100.00 to $500,000,000 are supported at all interest rates and
loan lengths.

Interest Rate Enter the annual interest rate as a percentage.    For example, if 
the annual interest on the loan is 9 3/4%, type in 9.75.    Do not 
enter a percent sign ("%").    Interest rates from 0.10% to 
25.00% are allowed.

Mortgage Length Enter the term of the loan in years.    The term must be a 
number from 1 to 30 years.

Payment Options Select the frequency of payments, either every two weeks, 
twice a month, or once a month.

Loan Starts Enter the date the loan starts.    Date format is MM/DD/YYYY.    
Example:    for 1 Dec 1991 enter 12/01/1991.    The loan start 
date must be between    1 Jan 1900 and 31 Dec 2100.

When all the parameters of the loan have been entered, press the Payment button or the 
Enter key to calculate and display the payment amount.    To close the Mortgage Information 
dialog box, press the Done button.



Calculate Remaining Balance Help
When you have entered the number of payments made, press the Calculate button or the 
Enter key to calculate and display the payment amount, principal paid, interest paid and 
loan balance.    To close the Analysis dialog box, press the OK button or the Enter key.    You 
may change the number of payments made and press Calculate or Enter as often as you 
wish to see the effect on your loan balance.    To close the Calculate Remaining Balance 
dialog box, press the Done button.



Calculate Equity vs Balance Help
When you have entered the number of payments made and the current estimated value, 
press the Calculate button or the Enter key.    A dialog box will appear with a total picture of 
where you stand on the mortgage.    To close the Analysis dialog box, press the OK button or 
the Enter key.    You may change the number of payments made/current value and press 
Calculate or Enter as often as you wish to see the effect on your loan balance.    To close the 
Calculate Equity vs Balance dialog box, press the Done button.



Calculate Missing Variable Help
When the Mortgage - Find Missing Information dialog box is displayed, it will contain all the 
information available from the Mortgage Master default info file (MM.INI) if it exists.    To 
calculate a new value for any of the variables, perform the following steps:

1. Modify any three of the four variables (Principal, Interest Rate, Term, or Payment). 
You also have the option of specifying whether the payments are every two 
weeks, twice a month, or monthly by selecting the desired item.

2. Select the item you want Mortgage Master to calculate from the Missing Item 
group.

3. Press the Calculate button or the Enter key to calculate and display the new 
values for the modified parameters.

What if you want to compare multiple mortgage choices?    Use the Log to File option to 
save the different sets of data you generate.    The data will be saved in a file (What-Ifs.Log).  
You can then view the file or delete it and start over with a new group of options for 
comparison.    The size of the log file is limited only by available free disk space.    Since 
viewing a large number of items in a list box is difficult, we recommend deleting the old log 
file and starting a new one whenever you start working with a new group of options.    

To close the Mortgage - Find Missing Information dialog box, press the Done button.

Note:    It is not necessary to clear the value from the box containing the variable you want to calculate.    
Mortgage Master will ignore the contents of that box when it calculates the item selected in the Missing Item 
group.



Amortization Schedule Help
An amortization schedule shows at a glance exactly how much of your every two weeks, 
twice a month,    or monthly mortgage payment goes to principal and interest, and the 
remaining balance on the loan for each payment.    It also summarizes the loan amount, 
term, interest rate and normal payment. This option in Mortgage Master complements the 
Calculate menu, Remaining Balance command, which calculates and displays only the 
principal, interest and remaining balance for any single payment period.

When the amortization schedule is displayed, the main menu of Mortgage Master will 
change.    The following new commands will be available:

Done! Returns to the main menu when you are done viewing the 
amortization schedule.

Next Page! Displays the next page of the amortization schedule.    When 
you reach the last page, this menu option will be grayed.

Previous Page! Displays the previous page of the amortization schedule.    
When the schedule is first displayed, this menu option will be 
grayed because you are on the first page.

Output Displays an Output Destination dialog box that lets you select 
where to send the output (printer or file), and which payments 
to include.

Help! Displays this page of help.

Notes:    

1.    The final payment will be different than the normal payment to compensate for the normal 
payment being rounded to the nearest cent.    To calculate the final payment, add or subtract (as 
appropriate) the remaining balance at the end of the schedule from the normal payment.

2.    Payment dates are determined differently based on the type of loan you select.

        a.    Every two weeks - Each payment will be 14 days from the last one.    The first payment will be 
due 14 days after the loan start date.

        b.    Twice a month - The dates are shown as the 1st and 15th of the month.    The first payment 
month is the month following the loan start date.

        c.    Monthly - The payments will fall on the same day each month unless there aren't that many 
days in the month.    In that case, the payment will be due the last day of the month.    February is 
considered to always have 28 days for purposes of payment due dates.    This avoids the problem of 
leap years where sometimes the payment would be due February 28th and sometimes February 29th.



Output Destination Help
The Output Destination dialog box allows you to specify where to send output and which 
payments to include in the output.

Output To? Selecting Printer will send the amortization schedule to your 
current printer.    If you have more than one printer installed in 
Windows, or if you wish to customize the format of the output, 
you may use the Printers option in the Windows Control Panel 
application to select or setup your printer.

Selecting File will send an amortization schedule to a file of your
choice.

Which Payments? This selection defaults to include all payments.    If you wish to 
output only a subset of the amortization schedule, select First, 
then Last, entering the range of payments you want included.

After selecting the destination and range of payments to output, press the OK button or the 
Enter key to send the amortization schedule to the printer or file.    If you selected Output to 
File, a dialog box will display to allow entering a filename.    After entering a filename (or 
accepting the default), press the OK button or the Enter key to begin sending the 
amortization schedule to the selected file.    To close the Output to File dialog box without 
saving the schedule to a file, press the Cancel button.    This action will also close the Output 
Destination dialog box and return you to the main window.    To close the Output Destination 
dialog box without taking any action, press the Cancel button.



Mortgage Master Commands
To get help with a particular command, choose the appropriate menu.

File Menu Commands
Edit Mortgage Info...
Save as Default Info
Exit

Calculate Menu Commands
Remaining Balance...
Equity vs Balance...
Cost of Loan
Missing Variable...

Reports Menu Commands
Amortization Schedule
Mortgage Comparisons

Tax Time    Menu Command
Yearly P and I...

F1 = Help Menu Commands
Index
Commands
Print Invoice
About Mortgage Master



File Menu Help
The File menu allows you to enter and save information about your mortgage.    All other 
menu commands in Mortgage Master operate on the information you enter here about the
parameters of your loan.

Edit Mortgage Info... Displays the Mortgage Information dialog box.

Save as Default Info Saves information entered in the Mortgage Information dialog 
box so that it may be recalled when Mortgage Master starts.   
The mortgage defaults which are shown under Edit Mortgage 
Info will be saved to a file called MM.INI in the default directory.

Exit Exits Mortgage Master.

When you start Mortgage Master, it automatically recalls the information entered in the 
Mortgage Information dialog box, if it was previously saved using the Save Default Info 
command. To exit the File menu without taking any action, click or drag the mouse 
anywhere outside the menu, or press the Esc (escape) key.



Calculate Menu Help
The Calculate menu allows you to compute various aspects of your mortgage.

Remaining Balance... Displays the Calculate Remaining Balance dialog box.    Given 
how many payments have been made, this command provides 
the value of the normal payment, the investment in principal 
and interest, and the balance due on the mortgage.

Equity vs Balance... Displays the Calculate Equity vs Balance dialog box.    Given how
many payments have been made and the estimated value of 
the property, this command provides an estimated overall value
for the property.    It takes into account the paid down principal 
and estimated market value for the property.

Cost of Loan Displays the Cost of Loan dialog box containing the total of all 
payments, the original loan principal, and the difference 
between the two.

Missing Variable Displays the Mortgage - Find Missing Information dialog box.    
Given any three of the four parameters needed to calculate a 
loan, this command calculates the missing parameter.    

To exit the Calculate menu without taking any action, click or drag the mouse anywhere 
outside the menu, or press the Esc (escape) key.



Reports Menu Help
The Reports menu allows displaying an amortization schedule of your mortgage or 
comparing mortgage options by varying different parameters of the loan.

Amortization Schedule Displays a complete amortization schedule for your mortgage.    
The Mortgage Master main menu is replaced by a new menu 
to allow navigating to all pages of the schedule and to output 
the schedule to a destination of your choice.

Mortgage ComparisonsDisplays a table comparing the principal and interest you 
entered in the Mortgage Information dialog box with four 
variations on both.

Principal is listed at the top of the each of the five columns on 
the right.    Your original principal is in the center column.    
Values for plus and minus 5% and 10% are shown in the two 
columns on either side of the original principal.

Interest is listed in the left column.    Your original interest is in 
the center row.    Values for plus and minus 0.5% and 1% are 
shown in the two rows above and below the original interest 
rate.

To exit the Reports menu without taking any action, click or drag the mouse anywhere 
outside the menu, or press the Esc (escape) key.



F1 = Help Menu Help
The F1 = Help menu brings up various types of help which make up the on-line 
documentation for Mortgage Master.

Index Displays the help index.

Commands Displays the complete list of menu commands.

Print Invoice Prints an invoice for registering Mortgage Master.    If you are 
evaluating the shareware version of the program, and you 
intend to make continued use of it, you are obligated to register
the program.    Improvements to Mortgage Master can only be
made if you support the shareware concept.    Shareware is not 
freeware or public domain software.    There are privileges and 
incentives to becoming a registered user.    Please read the 
README.DOC file for details.

About Mortgage Master Displays a dialog box containing the current program 
version, copyright notice and obligatory head-swelling credits 
for the authors.

To exit the F1 = Help menu without taking any action, click or drag the mouse anywhere 
outside the menu, or press the Esc (escape) key.



Tax Time Menu Help
Mortgage Master will calculate the amount of interest and principal paid on a yearly basis. 
This takes into account the different repayment options.    The calculations are quite 
extensive and may take a few seconds.    After the interest and principal are calculated for 
each year of the loan, they will be displayed in a list box.

The list box which shows the information can be controlled by both the keyboard and mouse.
Simply scroll through the listing until you find the year(s) you are looking for. 



What is Shareware?
Shareware is copyrighted commercial software that you are allowed to try out before you 
make the purchase decision.    It is a marketing concept, not a type of software.

Shareware marketing is typically used when the author doesn't have a huge advertising 
budget.    High end software like Lotus 1-2-3, dBase IV, etc. may have advertising budgets of 
over a million dollars.    A full page advertisement in a magazine like PC Magazine can cost 
over $10,000 an issue.    Smaller software companies, like MaeDae Enterprises, usually don't 
have that type of advertising budget so shareware marketing is used.

Many people question whether software distributed via shareware is of as high a quality as 
the software they see advertised in commercial magazines.    Good commercial advertising 
can sell almost any software regardless of its quality.    Shareware must be of equal or higher 
quality than commercially available software for users to register.    You, the user, have the 
opportunity to evaluate the shareware and find the real gems.    With commercial software, 
you purchase the software and then hope it works as advertised.    

Note:  Don't feel guilty about passing around copies of shareware.    You are helping the 
author distribute his software.    Even though shareware is commercial software, you are 
encouraged to pass around evaluation copies!



Registration Benefits
Registration benefits include:

1.    The latest version of    Mortgage Master with no additional information screens.
2.    Unlimited support - written or by phone.
3.    Low cost upgrades (only $10 plus $5 S&H).
4.    Notification of enhancements.

Note:    Shareware relies on you, the user, for its existence.    Your registration will help 
ensure Mortgage Master continues to improve.    When you register, please take the time to 
fill out the suggestion form.    We want Mortgage Master to evolve so it can better meet your 
needs.


